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 Computer Accounting with Sage 50 2016, 19th Edition, teaches you how 
to use Sage 50 2016 (formerly Peachtree) software. For more than 40 
years1, Sage Peachtree has produced award-winning accounting 
software. The Sage family of software products, which includes Sage 50, 
is the leading global supplier of business management solutions and 
services. Information about Sage Worldwide is shown on pages xxxv-
xxxvi. 
 
Sage operates in 24 countries and serves 6 million small and medium-
sized businesses (http://na.sage.com/us/about-us). Each year, tens of 
thousands of customers choose accountant-recommended Sage 50 for 
their business needs. Why? Because Sage 50 helps you do more to 
support the success of your business. Businesses that use Sage 50 
include retail stores, healthcare, human resources/payroll, construction/ 
real estate, transportation/distribution, payment processing, nonprofit, 
manufacturing, public utilities, legal, medical, accounting firms, home 
office businesses, and personal recordkeeping. 

  

   
Read Me: Multi-User Educational Version and Single User 
Student Version  

 

For the Educational Version serial number, email SageEducation@sage.com. The full 
Educational Version is free to schools, does not have a time limit, and can be installed 
on multiple computers (http://www.sage.com/us/about-us/education-instructor). Refer to 
page xx for Computer Lab Installation. 
 
The Student Version software can be installed on one computer and is valid for 14 
months. The Student Version serial number is 41EC6-FBE6-86BE-3ØFF. 

  
 In Computer Accounting with Sage 50 2016, 19th Edition, you learn about 

the relationship between Sage 50 software and fundamental accounting 
principles, procedures, and business processes.  
                                                      
 1In 1976, Peachtree Accounting Software was available.  

http://na.sage.com/us/about-us
mailto:SageEducation@sage.com
http://www.sage.com/us/about-us/education-instructor
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 The diagram below illustrates the Sage 50 accounting system. Business 
processes are completed in this order:  

 
• Software is installed, 
• Companies are set up, 
• Transactions are journalized in the special journals or general 

journal, then posted to the general ledger and subsidiary ledgers, 
• After entering transactions, reports are printed.  

 

     
 

Sage 50 is a real double-entry accounting system, not just an 
electronic checkbook. Double-entry accounting means that the equation 
Assets = Liabilities + Equity is always in balance. Since a debit in one 
account will be offset by a credit in another account, the sum of all debits 
is equal to the sum of all credits.  
 
To assure double-entry accounting procedures, Sage 50 includes 
monthly accounting periods, the general journal and special journals, 
general ledger and subsidiary ledgers, account reconciliation, an audit 
trail, and numerous financial reports. The Sage 50 accounting system 
also includes closing the fiscal year.  
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SAGE 50 2016  
 
The System Requirements for Sage 50 2016 are online at 
www.mhhe.com/yacht2016 > link to System Requirements. Each 
textbook includes a copy of the software, Sage 50 2016.  
 

NEW The software, Sage 50 2016, is included with every textbook. For 
software installation instructions, see pages vi-xviii. 

 
NEW Use this serial number 41EC6-FBE6-86BE-3ØFF for installing the 

Student Version software. The student version is valid for 14 months and 
then it expires. The expiration date can be found in the Company 
Information section of the System Navigation Center and on the Maintain 
> Company Information window. 

 
NEW After installation, you must activate the software. Refer to Step 14, pages 

xiv-xv. The Help menu includes software activation. 
 
 Compatible with Windows 8, Windows 7, and Vista. System requirements 

at www.mhhe.com/yacht2016. Sage 50 2016 was tested with Windows 
10. 

 
NEW  For installation on multiple classroom computers, email 

SageEducation@sage.com, 800-256-8807; instructor software, 
www.sage.com/us/about-us/education-instructor. Information for 
educators is included at www.mhhe.com/yacht2016, Install Sage 50 link. 
Refer to page xx, Computer Lab Installation.  

 
 GO GREEN & SAVE is included within the textbook chapters and on the 

Online Learning Center. There is no need for hard-copy printouts. 

NEW Watch Sage Advisor video . Videos link to information about features 
and technical support. 

 
 Online Learning Center at www.mhhe.com/yacht2016 includes two 

appendixes: Appendix C, Review of Accounting Principles; Appendix D, 
Glossary. 

 
NEW  The Online Learning at www.mhhe.com/yacht2016 includes YouTube 

videos, narrated PowerPoints, Online quizzes include Multiple-Choice 
and True/False questions, QA Templates (end-of-chapter questions and 
analysis questions), Going to the Net exercises, and Assessment 
Rubrics. 

  

http://www.mhhe.com/yacht2016
http://www.mhhe.com/yacht2016
mailto:SageEducation@sage.com
http://www.sage.com/us/about-us/education-instructor
http://www.mhhe.com/yacht2016
http://www.mhhe.com/yacht2016
http://www.mhhe.com/yacht2016
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 How to fix?, Troubleshooting, Comment, and Read Me boxes within 
chapters identify and help resolve issues. To find How to fix?, 
Troubleshooting, Comment, and Read Me, use the chapter index. 

 
NEW Bellwether Garden Supply project includes questions for analyzing the 

sample company data, identifying software features and functions, and 
reviewing sample company transactions and reports. The Bellwether 
Garden Supply project is online at www.mhhe.com/yacht2016. 

   
 Sage 50’s emphasis on double-entry accounting and business processes 

is explained throughout the textbook. Accounting skills are applied to all 
facets of running a business. Students create 12 companies, complete 
the accounting cycle, and practice computer accounting skills.  

 
NEW Financial Manager Analysis includes the Business Summary of financial 

ratios and Key Balances from the income statement and balance sheet. 
 
NEW Assessment online: Rubrics, graded interactive quizzes, QA templates, 

and analysis questions.  
 
NEW Source document practice set: The merchandising business practice 

set includes source documents, reviews special journals and subsidiary 
ledgers, and the accounting cycle. Online at www.mhhe.com/yacht2016. 

 
 Chapter 8, Stone Arbor Landscaping: Time and Billing. Use Sage 50's 

time and billing feature to record a time ticket, enter a sales invoice, and 
record payroll for jobs completed.  

 
 Chapters 1-18 include saving Sage 50 reports as Adobe Acrobat PDF 

files, and exporting reports to Excel. 
 
 Payroll tax tables for 50 states. Example payroll withholdings are 

included in Chapter 4, Employees; Chapter 15, Employees, Payroll, and 
Account Reconciliation; Exercise 15-1, Student Name Sales and Service; 
Project 2, Highland Sports; and Project 4, CW Manufacturing, Inc. 

 
NEW  End-of-chapter exercises include Check Your Figures. 
 
  Use Sage 50's import/export feature to copy lists into another company. 

     
   

http://www.mhhe.com/yacht2016
http://www.mhhe.com/yacht2016
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Sage 50’s modular system design is explained and compared to other 
accounting information systems. Workflow diagrams illustrate Sage 50's 
system design. 
 

 An accounting software diagram illustrates where Sage 50 fits into the 
range of accounting software applications.   

 
NEW Illustrations show Sage 50’s emphasize on the double-entry accounting 

system. 
 
NEW Sage 50 is compared to QuickBooks Online and Desktop versions and 

Microsoft Dynamics.  
 
Computer Accounting with Sage 50 2016, 19th Edition, shows you how to 
set up service, merchandising, nonprofit, and manufacturing businesses. 
When the textbook is completed, you have a working familiarity with 
Sage 50 Complete Accounting 2016 software. You learn how computer 
accounting and the general ledger accounting cycle work together.  
 
The Part 1, 2, 3, and 4 introductions include a chart showing the chapter 
number, Sage 50 backups, Excel and Adobe file names, size in kilobytes 
of each file backed up or saved, and page numbers where each backup, 
Excel, and Adobe PDF file is completed. 

  
 What's New in Sage 50 2016? 

 
The Help menu includes the new Sage 50 2016 software features. To 
see that window, follow these steps: 
 
1. Start Sage 50. 
 
2. Open the sample company, Bellwether Garden Supply. (Detailed 

steps for installing the software and starting Bellwether are on pages 
vi-xviii.) 

 
3. From Bellwether Garden Supply's menu bar, select Help > What's 

New. Getting started videos, show-me-how videos and quick 
reference guides are included. 
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4. On the What's New window, click  to see more. Read the 
information on these windows to review the new software features. 

Click  to review information. When through, click 

. 
 

PART 1:  EXPLORING SAGE 50 2016 
  

 There are two sample companies included with the software: Bellwether 
Garden Supply and Stone Arbor Landscaping. Bellwether Garden Supply 
is a retail and service company that demonstrates Sage 50's inventory 
and job tracking capabilities. Stone Arbor Landscaping is a service 
company that demonstrates time and billing features.  
 

Each part of the textbook includes a summary. Refer to pages 1 and 2 for a 
summary of Part 1. Pages 2 and 3 include a chart showing chapter numbers, 
files backed up and saved (.ptb, .pdf, .xlsx), file sizes, and page numbers 
where work was completed. 

  
 Part 1, Chapters 1-8, shows how to backup (save) files, export Sage 50 

reports to Excel and save reports as Adobe PDF files. Sage 50’s system 
design is explained. This includes how Sage 50’s user interface is 
organized into general ledger, accounts receivable, accounts payable, 
inventory, payroll, and job costing modules. 
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 In Part 1 of the textbook, you complete eight chapters that demonstrate 
how Sage 50 is used. This introduces you to the procedures that will be 
used with all the chapters of the textbook. Beginning in Part 2, you set up 
companies from scratch. 

 
NEW Chapter 1, Introduction to Bellwether Garden Supply, includes Sage 50’s 

Navigation Centers and Restore Wizard for opening new or existing 
companies. The new Navigation Bar and menu bar selections are 
explained. Bellwether Garden Supply is updated to March 2016.  

 
 Chapter 2, Vendors, shows you how to view accounts payable lists and 

reports from the Vendors & Payables Navigation Center as well as 
custom date filtering and how to add columns to reports. New sections 
include Receive Inventory from a Purchase Order and Apply to Purchase 
Order. Sage 50’s accounts payable system is explained.  

 
 Chapter 3, Customers, shows you how to view customer lists and reports 

from the Customers & Sales Navigation Center as well as custom date 
filtering and how to add columns to reports. Chapter 3 includes Sales 
Orders and Ship Items from a Sales Order. Sage 50’s accounts 
receivable system is explained. 

 
NEW  Sage 50’s Financial Manager includes financial ratios and key balances. 
  
 Chapter 4, Employees, shows you how to navigate Sage 50's Employees 

& Payroll system. 
  
 Chapter 5, General Ledger, Inventory, and Internal Control, shows you 

Sage 50’s budget feature, how selected access for security is used, 
internal controls, and audit trail. Sage 50’s inventory system is also 
included. 

 
 Chapter 6, Job Cost, shows you how to use Sage 50's job cost system. 
 
 Chapter 7, Financial Statements, shows the result of work completed in 

Chapters 1-6.  
 

NEW After Chapter 7, the Bellwether Garden Supply Project can be completed. 
It is included online at www.mhhe.com/yacht2016.  

  
 In Chapter 8, Stone Arbor Landscaping: Time & Billing, you work with a 

service company that demonstrates Sage 50's time and billing features. 

http://www.mhhe.com/yacht2016
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In Exercises 8-1 and 8-2, you record time and billing transactions, 
including a time ticket that is applied to a sales invoice and payroll entry. 
 
PART 2:  SAGE 50 2016 FOR SERVICE BUSINESSES 
 
Chapters 9, 10, 11, Project 1, and Project 1A are included in this section 
of the textbook. The work completed in Chapter 9 is continued in 
Chapters 10 and 11. The accounting cycle is completed for the fourth 
quarter of the year and includes adjusting entries and closing the year. 
 

For the Part 2 summary, refer to pages 251-256. Pages 254-256 include a 
chart showing chapter numbers, files backed up and saved (.ptb, .pdf, .xlsx), 
file sizes, and page numbers where work was completed. 

 
NEW In Chapter 9, New Company Setup and Beginning Balances, you set up 

two service companies—Donald Watson Designer and Crafts by Student 
Name with Sage 50’s simplified chart of accounts. You use Sage 50’s 
new Company Setup Wizard and enter beginning balances.  The 
companies set up in Chapter 9 continue in Chapters 10 and 11.  

  
 In Chapter 10, Maintaining Accounting Records for Service Businesses, 

you record entries for October in the Write Checks and Receipts 
windows, use Sage 50’s account reconciliation feature and print reports. 
You also backup, and save reports in Excel and Adobe PDF format. 

 
Chapter 11, Completing Quarterly Activities and Closing the Fiscal Year, 
you complete transactions for November and December, record adjusting 
entries, print financial statements, and close the fiscal year. 

 
NEW Exercises 9-1 through 11-2 include three months of transactions, account 

reconciliation, adjusting entries, financial statements, Sage 50’s closing 
procedure, and Check Your Figures. Sage 50 reports are backed up, and 
saved in Adobe PDF format and exported to Excel. 
 

NEW Project 1, Shelly Martin, Accounting, is a comprehensive project that 
reviews what you learned in Chapters 9, 10, and 11.  

 
Project 1A, Student-Designed Service Business, shows you how to 
design a service business from scratch. You set up the business, choose 
a chart of accounts, create a Balance Sheet, write business transactions, 
complete the computer accounting cycle, and close the fiscal year. 
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PART 3:  SAGE 50 2016 FOR MERCHANDISING BUSINESSES 
 
Chapters 12, 13, 14, 15, Project 2, and Project 2A are included in this 
section of the textbook. Students set up two merchandising businesses in 
Chapter 12—Wendy's Service Merchandise and Student Name Sales 
and Service. The work started in Chapter 12 is continued in Chapters 13, 
14 and 15. 

  

For the Part 3 summary, refer to pages 399-402. Pages 400-402 include a 
chart showing chapter numbers, files backed up and saved (.ptb, .pdf, .xlsx), 
file sizes, and page numbers where work was completed. 

 
 In Chapter 12, Vendors & Purchases, use Sage 50’s accounts payable 

system, set up vendor defaults, record inventory purchases and 
payments from vendors, automatically track vendor discounts, and use 
vendor credit memos for purchase returns.   

 
 In Chapter 13, Customers & Sales, use Sage 50’s accounts receivable 

system, set up customer defaults, record cash and credit sales and 
receive payments from customers, use credit memos for sales returns.  

 
NEW Chapter 13 includes Financial Manager Analysis. Business summary 

financial ratios are shown and key balances for income statement and 
balance sheet accounts. 

 
Chapter 14, Inventory & Services, shows you how to use Sage 50's 
inventory system.  
 

 Chapter 15, Employees, Payroll and Account Reconciliation, shows Sage 
50’s payroll system using two states, Arizona and Georgia, as an 
example for payroll withholdings. You set up payroll defaults, add 
employee information, learn about automatic payroll tax calculations, and 
complete payroll entry.  

 
 Account reconciliation shows you how Sage 50’s Accounts Payable, 

Accounts Receivable, Inventory, and General Ledger systems work 
together. Chapter 15 includes account reconciliation for both the 
checking and payroll accounts. Check Your Figure amounts are included 
for Exercises 12-1 through 15-2. 

 
NEW Project 2, Highland Sports, is a comprehensive project that incorporates 

what you have learned in Chapters 12 through 15. Project 2 includes 
payroll withholdings for Oregon. 
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Project 2A, Student-Designed Merchandising Business, asks you to 
create a merchandising business from scratch. 
 
PART 4:  ADVANCED SAGE 50 2016 APPLICATIONS 
 

 Chapters 16, 17, 18, Project 3, Project 4, and Project 4A are included in 
this part of the textbook. Chapter 16, Customizing Forms, shows you how 
to use Sage 50's design tools. Chapter 17, Import/Export, shows you how 
to export data from Sage 50 to a word processing program and how to 
import lists into a company. In Chapter 18, Microsoft Word and 
Templates, you copy a Sage 50 report to Word and look at vendor, 
customer, and employee templates included with the software.  

 
For the Part 4 summary, refer to pages 617-618. Page 618 includes a chart 
showing chapter numbers, files backed up and saved (.ptb, .pdf, .xlsx, .docx, 
.doc, .txt, .csv), file sizes, and page numbers where work was completed. 

 
Chapter 16, Customizing Forms, includes design tools for report 
customization. 
 

 In Exercises 16-1 and 16-2, forms and financial statements are 
customized. 

 
 Chapter 17, Import/Export, includes how to import a chart of accounts 

into another company and export to a word processing program. 
 
 In Exercises 17-1 and 17-2 import lists from Bellwether Garden Supply 

into the new company set up in Chapter 17. 
  
 Chapter 18, Microsoft Word and Templates, includes copying reports to 

Word, using templates and the write letters feature. 
 
NEW Project 3, Springfield Computer Club, is a nonprofit business.  
 
NEW Project 4, CW Manufacturing, Inc., is the culminating project in your study 

of Sage 50 2016. Project 4 includes payroll withholdings for 
Pennsylvania. 
 
Project 4A, Student-Designed Project, instructs you to write another 
month's transactions for one of the four projects completed. 
 
Each chapter ends with an Index for that chapter. There is also an Index 
at the end of the book. 
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CONVENTIONS USED IN TEXTBOOK 
 
As you work through Computer Accounting with Sage 50 2016, 19e, you 
should read and follow the step-by-step instructions. Numerous screen 
illustrations help you to check your work. The following conventions are 
used in this textbook: 
 
1. Information that you type appears in boldface; for example, Type 

Supplies in the Account ID field. 
 

2. Keys on the keyboard that should be pressed appear in angle 
brackets; for example, <Enter>. 

 
3. Sequences of software selections are indicated by a greater than 

symbol (>). 

Examples:  >  > New Bill 
From the menu bar, select File > Close Company 

4. When you see this icon , there is a video, on the textbook 
website at www.mhhe.com/yacht2016 > Student Edition link > 
select the appropriate chapter > link to Videos or YouTube > then 
select the video. 
 

5. This icon— —reminds you to check the Sage 50 work 
completed. 
 

6. Buttons and picture icons are shown as they appear on the screen. 

Examples:  (Next button);  (Display icon) 
 
SAGE WORLDWIDE  
 
Sage customers cover a wide range of small and medium-sized 
businesses. Sage software is used for personal recordkeeping and 
home-office customers, small businesses with just a few employees, and 
larger enterprises that distribute across North America. 
 

http://www.mhhe.com/yacht2016
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• Established more than 40 years ago.
• Headquartered in the U.K. with offices across North America, Latin

America, Europe, Africa, Middle East, Asia, and Oceania.
• Publicly traded on the London Stock Exchange (LSE: SGE).
• Generates more than $2 billion in revenue.
• Serves more than 6 million customers.
• Advises 1.9 million customers through support contracts.
• Manages 33,000 customer calls a day.
• Employs more than 13,000 people.
• Parent company of Sage North America.

mailto:carol@carolyacht.com
http://www.mhhe.com/yacht2016

	Preface

